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Change History
DateSeeChange

December 2020Browser Support and Self-Signed certificatesAdded Edge Chromium
Browser Support and
Self-Signed certificates

January 2020Initial Release of Document for Release 12.5

Access Unified Intelligence CenterSupport to HTTP removed.

Browser SupportUpdated Browser Support

Dashboards > OverviewAddressed injection
vulnerabilities

Create a Schedule for a ReportChanged Large Schedule
Frequency

About This Guide
This guide explains the following functionality of the Cisco Unified Intelligence Center reporting application.

• Dashboards

• Reports

• Permalinks
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• Schedule Reports

• View Help

• Gadget Toolbar

• Live Data Failover

Audience
This guide is intended for Cisco Unified Intelligence Center users to manage dashboards, manage reports,
filter report data, run reports, schedule a report, retrieve permalinks and more.

Related Documents
• Cisco Unified Intelligence Center Guides at
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-intelligence-center/tsd-products-support-series-home.html

• Cisco Unified Intelligence Center Developers' Forum at
https://developer.cisco.com/site/reporting/overview/

Communications, Services, and Additional Information
• To receive timely, relevant information from Cisco, sign up at Cisco Profile Manager.

• To get the business impact you’re looking for with the technologies that matter, visit Cisco Services.

• To submit a service request, visit Cisco Support.

• To discover and browse secure, validated enterprise-class apps, products, solutions and services, visit
Cisco Marketplace.

• To obtain general networking, training, and certification titles, visit Cisco Press.

• To find warranty information for a specific product or product family, access Cisco Warranty Finder.

Cisco Bug Search Tool

Cisco Bug Search Tool (BST) is a web-based tool that acts as a gateway to the Cisco bug tracking system
that maintains a comprehensive list of defects and vulnerabilities in Cisco products and software. BST provides
you with detailed defect information about your products and software.

Documentation Feedback
You can provide comments about this document by sending an email to the following address:

contactcenterproducts_docfeedback@cisco.com

We appreciate your comments.
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C H A P T E R 1
Introduction to Cisco Unified Intelligence Center

• Overview, on page 1
• Access Unified Intelligence Center, on page 2
• Default Locale in Unified Intelligence Center, on page 2
• Synchronize Cluster, on page 3
• Browser Support and Self-Signed Certificates, on page 3

Overview
Cisco Unified Intelligence Center is a reporting platform for users of Cisco Contact Center products. It is a
web-based application that provides Historical, Real-time, and Live Data reporting and dashboards.

Unified Intelligence Center serves the following primary purposes:

• Obtains data from the base solution's database. The base solution can be any of the Contact Center
products.

• Allows you to create custom queries to obtain specific data.

• Customizes the visual presentation of the reports.

• Customizes the report data.

• Allows different groups of people to view specific data based on their roles.

Customer Journey Analyzer

Unified Intelligence Center users can use the reporting platform to launch Customer Journey Analyzer using
Analyzer from the left navigation pane.

You can customize the default Analyzer URL using the CLI set cuic analyzer url <urlname>.

For more information on the CLI, see Cisco Unified Intelligence Center Administration Guide at
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-intelligence-center/products-maintenance-guides-list.html.

The Customer Journey Analyzer mines historical data from multiple data sources and systems to generate
specific business views of data. The Analyzer visually displays trends to help you identify patterns and gain
insight for continuous improvement.
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You must have completed the on boarding process for Cloud Connect to access Customer Journey Analyzer.
Cloud Connect allows Cisco Contact Center on premises customers to connect to cloud services, such as
Customer Journey Analyzer to use Business Metrics.

Note

For more information, see Business Metrics related information in the corresponding solution Features Guide.

Access Unified Intelligence Center
The URL for logging in to the Unified Intelligence Center reporting application is:

HTTPS

https://<HOST>:8444/cuicui/Main.jsp

Where HOST is the DNS name of a Unified Intelligence Center node.

Cisco Unified Intelligence Center does not support HTTP.Note

Default Locale in Unified Intelligence Center

To specify a locale, install the language pack.Note

First time access to Cisco Unified Intelligence Center displays the sign in page in the browser locale. To
change the locale, click the username on the top-right corner of your screen and select the required locale
from the drop-down list.

When you select a locale, the browser retains the locale information even after you sign out and sign in back
to Cisco Unified Intelligence Center within the same browser.

Table 1: Supported Languages

DutchDanishChinese
(Traditional)

Chinese (Simplified)Brazilian Portuguese

JapaneseItalianGermanFrench (France)English (U.S.)

PolishSwedishSpanish (Spain)RussianKorean

BulgarianČeština (Czech)NorwegianFinnishTurkish

Slovenščina
(Slovenian)

Slovenčina (Slovak)Magyar (Hungarian)Hrvatski (Croatian)Català (Catalan)

Română (Romanian)Српски (Serbian)
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Synchronize Cluster
System Configuration Administrator can use the Synchronize Cluster feature (link below the username on
the top-right corner of your user interface screen) to notify all nodes in the cluster to clear their local cache.
This action synchronizes and empties all caches in the cluster. Clearing the locale cache forces each node to
go directly to the database for the requested information.

Each node gets fresh data from the database. The data is automatically put into the local cache and accessed
during future requests. Data remains consistent in the database and hence there is no loss of information.

For more information, see Unified Intelligence Center Cache section in the Administration Console User
Guide for Cisco Unified Intelligence Center at
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-intelligence-center/products-maintenance-guides-list.html.

Browser Support and Self-Signed Certificates
Unified Intelligence Center supports:

• Firefox ESR 68 and higher ESRs

• Edge Chromium (Microsoft Edge V79 and later)

• Chrome 76.0.3809 and higher

In the above mentioned browsers, ensure to manually close the certificate acceptance window to load the Live
Data reports.

Note

Self-Signed Certificates

Ensure that the pop-ups are enabled for Cisco Unified Intelligence Center.

After you enter the Cisco Unified Intelligence Center URL in your browser, the procedure to add a certificate
is as follows:

Install certificates on Windows operating system:

The procedure to add a certificate varies for each browser. The procedure for each browser is as follows:

Firefox

1. A page appears with the warning that states this connection is untrusted.

2. On the browser tab, click I Understand the Risks > Add Exception.

3. On the Add Exception dialog box, ensure that Permanently store this exception box is checked.

4. Click Confirm Security Exception.

The warning page closes automatically.

5. Enter your credentials and click Sign In.
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Repeat the preceding steps for all the certificate links. After you accept all the certificates, the sign-in process
is complete.

Chrome and Edge Chromium (Microsoft Edge)

1. A page appears with the warning that states that there is a problemwith your website's security certificate.

In Chrome, click Advanced > Proceed to <Hostname> (unsafe).

In Microsoft Edge, click Advanced > Continue to <Hostname> (unsafe).

The sign in page opens and a certificate error appears in the address bar of your browser.

2. Click on the Certificate Error, and then,

In Chrome, click Certificate (Invalid).

In Microsoft Edge, click Certificate (not valid).

The Certificate dialog box appears.

3. In the Details tab, click Copy to File.

The Certificate Export Wizard dialog box appears.

4. Click Next.

5. Keep the default selection DER encoded binary X.509 (.CER) and click Next.

6. Click Browse and select the folder in which you want to save the certificate.

7. Enter a recognizable File name and click Save.

8. Click Next.

9. Click Finish.

A successful export message appears.

10. Click OK and close the Certificate Export Wizard.

11. Browse to the folder where you have saved the certificate file (.cer file), right click on the file, and click
Install Certificate.

The Certificate Import Wizard dialog box appears.

12. Keep the default selection Current User and click Next.

13. Select Place all certificates in the following store and click Browse.

The Select Certificate Store dialog box appears.

14. Select Trusted Root Certification Authorities and click OK.

15. Click Next.

16. Click Finish.

A Security Warning dialog box appears asking if you want to install the certificate.

17. Click Yes. A Certificate Import dialog box states that the import was successful appears.

18. Click OK.

19. Enter your credentials and click Sign In.
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Close the browser and sign in to Cisco Unified Intelligence Center. The security error does not appear in the
address bar.

Install certificates on macOS:

The procedure to download a certificate varies for each browser. The procedure for each browser is as follows:

Chrome and Edge Chromium (Microsoft Edge)

1. A warning page appears which states that your connection is not private. To open the Cisco Unified
Intelligence Center sign in page,

In Chrome, click Advanced > Proceed to <Hostname> (unsafe).

In Microsoft Edge, click Advanced > Continue to <Hostname> (unsafe).

2. Click on the certificate error that appears in the address bar and then,

In Chrome, select Certificate (Invalid).

In Microsoft Edge, select Certificate (Not Valid).

A certificate dialog box appears with the certificate details.

3. Drag the Certificate icon to the desktop.

4. Double-click the certificate. The Keychain Access application opens.

5. In the right pane of Keychains dialog, browse to the certificate, right-click on the certificate, and select
Get Info from the options that are listed. A dialog appears with more information about the certificate.

6. Expand Trust. From the When using this certificate drop-down, select Always Trust.

7. Close the dialog box that has more information about the certificate. A confirmation dialog box appears.

8. Authenticate the modification of Keychains by providing a password.

9. The certificate is now trusted, and the certificate error does not appear on the address bar.

Firefox

1. In your Firefox browser, enter the Cisco Unified Intelligence Center URL. A warning page appears which
states that there is a security risk.

2. Click Advanced and then click View Certificate link. The Certificate Viewer dialog box appears.

3. Click Details and then click Export. Save the certificate (.crt file) in a local folder.

If .crt file option is not available, select .der option to save the certificate.Note

4. From the menu, select Firefox > Preferences. The Preferences page is displayed.

5. In the left pane, select Privacy & Security.

6. Scroll to the Certificates section and click View Certificates .... The Certificate Manager window is
displayed.

7. Click Import and select the certificate.
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8. The certificate is now authorized, and the certificate error does not appear on the address bar.

Screen Resolution Support

Supported screen resolution for Cisco Unified Intelligence Center: 1366 x 768 or higher.

Cisco Unified Intelligence Center User Guide, Release 12.5(1)
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C H A P T E R 2
Dashboards

• Overview, on page 7
• Dashboard Actions, on page 8
• Add Widgets to Dashboard, on page 10
• Run a Report from the Dashboard, on page 13

Overview
In Cisco Unified Intelligence Center, Dashboard is an interface that allows you to add reports, web pages
(URLs), web widgets, and notes in a consolidated view.

All actions on the Dashboards interface are based on your role and on the user permissions for Dashboards
and for Folders.

Access Dashboards

From the left navigation pane, click Dashboards to access the list of all the available Dashboards. This list
includes the dashboards that you have created and the dashboards created by other users on which you have
View permissions.

• You must be assigned with the Dashboard Designer role to create Dashboards.

• To view Dashboards created by other users, you must have View permissions for the dashboard and its
parent folder.

• Cisco Unified Intelligence Center does not provide a default Dashboard.

Note

Run Dashboards

To run a Dashboard, click the Dashboard name. When the Dashboard is in the run mode, use the toolbar to:

• Edit the Dashboard.

• Refresh the Dashboard data.

• Maximize the Dashboard view.

Cisco Unified Intelligence Center User Guide, Release 12.5(1)
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Press Esc to restore the original view.

Before You Upgrade

Cisco Unified Intelligence Center 12.5 supports a maximum of ten widgets per Dashboard. Hence, for
Dashboards with more than ten widgets in versions before 12.5, ensure to split those Dashboards with a
maximum of ten widgets each before upgrade.

Consider a Dashboard with 15 widgets in Unified Intelligence Center versions before 12.5. Before upgrading
to version 12.5, use the Save As feature to clone the Dashboard and manage the widgets up to ten per
Dashboard.

Unsupported Widgets

The Cisco Unified Intelligence Center 12.5 interface for Dashboards does not support the following widgets:

• Schedule Report widgets

• URL widgets containing Dashboard permalinks (Nested Dashboards)

Migration Limitations

To address injection vulnerabilities, the Custom Widget feature in Dashboards is disabled by default. If any
custom widgets were added to the Dashboards in versions earlier to Unified Intelligence Center 12.5, those
widgets are visible in the read-only mode post upgrade to version 12.5. You can opt to retain or delete them.

To enable the Custom Widget feature, use the CLI set cuic properties dashboard-customwidget-enabled
and set the parameter value to "on". For more information, see Administration Console User Guide for Cisco
Unified Intelligence Center at
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-intelligence-center/products-maintenance-guides-list.html.

Dashboard Actions
The following table lists various actions that you can perform from the Dashboard.

You can open a maximum of ten tabs at a time.Note

Table 2: Dashboard Actions

DescriptionAction

Dashboard-level actions

New

Cisco Unified Intelligence Center User Guide, Release 12.5(1)
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DescriptionAction

Creates a new Dashboard.

The New Dashboard wizard allows you to:

• Provide Dashboard properties; Name and Description.

• Add widgets to the Dashboard.

For more information, see Add Widgets to Dashboard.

Dashboard

Creates a new Folder. Use this feature to categorize Dashboards.

When you move or save the folders to a different
location, the drop-down lists all the folders. You can
only navigate into the folders on which you have the
Edit permission.

Note

Folder

Toolbar actions

Refreshes the Dashboards page.Refresh

To easily access your Dashboards, you can tag Dashboards as
Favorites.

Click the star icon beside the Dashboard name to add to Favorites.

Favorites

Searches for a particular Dashboard.Search

Ellipsis (…) actions

Edits the Dashboard details. In the edit mode, you can:

• Add, remove, and modify widgets.

• Click the icon next to the Dashboard name to edit the
Dashboard properties; name and description.

After editing the Dashboard, click Save.

Edit

Saves a copy of the Dashboard.Save As

Renames a Dashboard or a Folder.Rename

Moves Dashboard or Folder from one folder to another.

You can move a Dashboard or a Folder only if you
have Edit permission on the parent folder of the
Dashboard or Folder being moved.

Note

Move

Deletes a Dashboard or a Folder.

You can delete a Dashboard or a Folder only if you
have Edit permission on the parent folder of the
Dashboard or Folder being deleted.

Note

Delete
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DescriptionAction

Assigns appropriate permissions to access and manage the
Dashboard.

Groups—Grants View and Edit permissions for the Dashboard
to various groups.

• Security Administrators can grant these permissions to
various groups.

• Entity owners can grant these permissions to groups that they
are directly associated with.

Users—Grants View and Edit permissions for the Dashboard to
various users. Applicable only to Security Administrators.

Note • Higher permissions (View and Edit) from either
an individual user or the user group takes
precedence.

• Only the first 200 records (alphabetical order)
are displayed in theMembers orGroups panel.
To view more records, see Configure >
Groups.

• When you modify a permission and want to
switch between Groups and Users tabs, you
will be prompted to either save or discard the
changes.

Permissions

Displays the Dashboard permalink.

You can access permanent hyperlink only from a
web browser. You cannot access it from an
application such as Microsoft Excel to pull data or
display a Dashboard.

Note

For more information, see Permalink for a Dashboard.

Permalinks

Related Topics
Add Widgets to Dashboard, on page 10
Permalink for a Dashboard, on page 45

Add Widgets to Dashboard
You can add Reports, Web pages, Notes, and Custom Widgets to a Dashboard. In addition, you can resize
and reposition the widgets to suit your needs. The default widget size depends on the available space on the
Dashboard canvas.
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You can add a maximum of ten widgets per Dashboard.Note

To add widgets to the Dashboard, perform the following steps:

Procedure

Step 1 From the left navigation pane, click Dashboards.
Step 2 In the Dashboards tab,

• To add widgets to a new Dashboard, click New > Dashboard.

• To add widgets to an existing Dashboard, click the ellipsis icon beside the required Dashboard and click
Edit.

Step 3 On the Dashboard canvas, click on the plus icon.
Step 4 In the Add Widgets dialog box, add the required widgets:

StepsWidget Type

Displays an existing report on the Dashboard.

a. Click the Report View icon.

b. In the Add Report View dialog box, select the Report and the Views
from the corresponding drop-down list.

c. Click Done.

Note • For a Report widget, you can click the icons on the
widget header to view the existing filter information,
manage filters, and play or pause the running of report.

• TheManage filters and the View filter information icons
appear only when you hover on the report widget.

• For Grid view reports, you can increase or decrease the
font size of the report data.

The default font size is set to 10. Post upgrade to Cisco
Unified Intelligence Center 12.0 or later, this setting
overrides the font size set during the grid view creation.

• In the edit mode, from the Report widget header, use the
ellipsis icon to access Filter and modify the filter criteria.

• Drilldown reports are not supported.

Report View
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StepsWidget Type

Adds notes to the Dashboard.

a. Click the Note icon.

b. In the Add a Note dialog box, enter Note Title and Note Body.

c. Click Done.

Note

Displays a web page on the Dashboard.

a. Click the Web page icon.

b. In the Add a Web page dialog box, enter Web URL, the address of
the web page that you want to display on the Dashboard.

c. Click Done.

Limitations for web page widget:

• The websites enabled with "X-Frame-Options", will not be
displayed on the Dashboard.

• The web URLs provided without prefixing a protocol (HTTPS)
will by default use the protocol of the Cisco Unified Intelligence
Center application.

• When Cisco Unified Intelligence Center is in HTTPS mode, you
cannot configure HTTP based widget URLs in Dashboard.

• You cannot add Dashboard permalink as web page widget.

For information on viewing report permalinks in Dashboards as web page
widgets, see View Report Permalinks in Dashboards.

Web page
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StepsWidget Type

Adds custom widgets to the Dashboard.

a. Click the Custom Widget icon.

b. In the Add Custom Widget dialog box, enter Widget Title and Code
Snippet.

In theCode Snippet box, you can enter any markup/code
snippet of the widget that you want to show on the
Dashboard. For example, HTML, XML RSS feed,
JavaScript, and so on.

Maximum Limit: 1000 characters.

Note

c. Click Done. The embedded code appears on the Dashboard.

By default, this widget type is disabled. You can enable the CustomWidget
feature using the CLI set cuic properties
dashboard-customwidget-enabled on.

For more information, see Administration Console User Guide for Cisco
Unified Intelligence Center at
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-intelligence-center/products-maintenance-guides-list.html.

Custom Widget

Step 5 Click Save.

Related Topics
View Dashboard Permalink

Run a Report from the Dashboard
Running a report from the Dashboard depends on the Skip filter during the report execution check box
during the report filter selection:

• If this check box is checked for a report, the system bypasses the filter and runs that report using the
default filter.

• If this check box is unchecked for a report, for the first access, the system prompts you to choose a Filter
to run that report.
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• The Skip filter during the report execution check box is not checked for
any of the stock reports. If you do not want a Dashboard report to require
filter selection upon first use, you must create a new report, set the default
filter, and check the Skip filter during the report execution check box.

• The Filter prompt displays the corresponding icon to denote the type of
report view, such as, Grid, Chart, Pie, and so on.

• In both these scenarios, from the ellipsis icon on the Report widget header
you can access Filter to edit the filter criteria.

Note

Click the Filter button to display the filter criteria in the Filter Data dialog box based on the following
validations:

• Displays the filter criteria screens based on the selected report query type.

• Populates with the default filter criteria if the default filter is set for that report.

Edit Filter Data

You can edit the report filter data from the Dashboard in the following two ways:

• Run mode—Click the filter icon on the report widget header.

• Edit mode—Click the ellipsis icon and select Filter from the available menu options.

Modify the required filter criteria and click Run. The report refreshes reflecting the modified filter criteria.

When you edit the report filter for a Dashboard during Create, Edit, or Run mode, the filter settings are stored
in the browser cache and is specific to the individual user. Hence, the next time you sign in and run the
Dashboard, the report widget uses the filter information stored in the browser cache and generates the report
(without prompting you to update the filter criteria). The browser cache is retained up to 30 days.

Every time you run the report, the filter data in the browser cache is validated for permissions. If there is a
permission mismatch, an error message appears that the filter you selected before is no longer valid and select
the filters again.

Also, if any other user sign-in to the same browser, that user cannot view your filter settings.

The filter settings stored in your browser cache are cleared only:

• If you have not used the Dashboard for the last 30 days.

• If you manually clear the cache.

Note

For more information on Report Filters, see Report Filters.

Related Topics
Report Filters, on page 20
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C H A P T E R 3
Reports

• Overview, on page 15
• Report Actions, on page 16
• Add Template Help, on page 19
• Report Filters, on page 20
• Report Types, on page 24
• Manage Reports, on page 27
• Run Report, on page 34
• Import Reports, on page 37
• Export Reports and Folders, on page 38

Overview
Reports show data returned by Report Definitions (database query). The database queries extract this data
and can be displayed in various Report Views—as grids and charts.

Users with the Report Designer user role can click the Reports from the navigation page to open the Reports
page.

All actions on the Reports interface are based on user role and on the user's object permissions for reports and
for folders.

Note

For more information about creating or editing a report, see Create Reports.

Related Topics
Create Reports, on page 27

Stock Reports
Cisco provides stock report templates to use with Unified Intelligence Center. You can download Stock reports
from Cisco.com. Stock report templates display data that has been saved in the Unified CCE database.

After installing Unified Intelligence Center, you can import stock templates using the Import feature and
customize the stock reports to suit your business requirements. You can clone the imported stock templates
using the Save As option and customize.
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Stock reports have one default grid view. Few stock reports also have a chart view.

Localization of stock report templates is not supported.Note

The available stock report templates are:

• Audit Trail—view the sequence of audit records of the transactions related to create, update, modify,
and delete that are performed on the entities of a Unified Intelligence Center server.

By default, only System Administrators can access and view this report. System Administrator can give
permissions to other Unified Intelligence Center users to use this report.

• Group Access Detail—view access rights of groups that use Unified Intelligence Center resources such
as Dashboards, Reports, and other resources.

• Resource Ownership and Access—view access rights of users and about ownership status of users who
use Unified Intelligence Center resources such as Dashboards, Reports, and other entities.

• User's Audit Log—view the audit log data of users such as, Logged In User Detail (name and role),
Event Detail, Updated Column, User Detail, and other modified details.

For more information, click the "?" icon (Template Help) from the report in the run mode.

Report Actions
The following table lists various actions that you can perform from the Reports.

You can open a maximum of ten tabs at a time.Note

Table 3: Report Actions

DescriptionAction

Report-level actions

New

Creates a new report in the selected folder.

You cannot create reports inside the Stock folder. You can only
import reports into the Stock folder. To edit or customize reports,
clone the report and edit the cloned version.

Note

Report

Creates a new Folder. Use this feature to categorize reports.

When you move or save the folders to a different location, the
drop-down lists all the folders including the disabled folders. You
can navigate to subfolders with Edit permissions.

Note

You cannot create folders inside the Stock folder.Note

Folder
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DescriptionAction

Toolbar actions

Refreshes the Reports page.

Applies to all folder levels (root, sub folder, and report).

Refresh

To easily access your reports, you can tag Reports as your Favorites.

Click the star icon beside the Report name to add to Favorites.

Favorites

Searches for a particular the Report.Search

Imports a report.

To import a report, you need the Report Designer, Report Definition Designer,
and Value List Collection Designer roles and the Edit permission on the target
folder where you want to import these reports.

For more information, see Import Reports.

Applies to all folder levels (root, subcategory, and report).Note

Import

Ellipsis(…) actions

Edits the Report details. In the edit mode, you can add, modify, and delete report
details, views and thresholds, and filters.

After editing the Report, click Finish.

You cannot edit a Stock report.Note

Edit

Saves a copy of the report with a different name.

Note • By default, the reporting users do not have permission to create
a subfolder in the Reports root folder. To get permissions,
contact your administrator.

• You cannot perform the Save As action to move contents
(reports or folders) into the Stock folder and its subfolders.

The report description does not support the following special
characters:

Note

• Parentheses (( ))

• Angle brackets (<,>)

• Forward slash (/)

• Question mark (?)

• Quotes (")

• Any scripts; JavaScript

Save As
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DescriptionAction

If you want to create a copy of the Report Definition that is associated with the
report being saved:

1. Click the Clone Report Definition check box.

2. Enter the new Report Definition Name and select the Report Definition
Location.

3. Click Save.

The new report gets associated to the cloned Report Definition.

Clone Report
Definition

Renames a folder or a report.

You cannot rename a Stock folder or a Stock report.Note

Applies to the root-level folder.Note

Rename

Moves Report or Folder from one folder to another.

Note • You can move a Report or a Folder only if you have Edit
permission on the parent folder of the Report or Folder being
moved.

• You cannot move custom folders or reports from within the
Stock folder (and its subfolders) to other locations and the other
way.

Move

Creates report filters.

For more information, see Report Filters.

You can also set the default filter by checking the Set as Default
check box in the Choose Filter dialog box during the report run
mode.

Note

Set Default Filters

Hosts the help page for Report Templates. For more information, see Add Template
Help.

Add Help

Deletes a report or a folder.

Note • You can delete a Report or a Folder only if you have Edit
permission on the parent folder of the Report or Folder being
deleted.

• Stock folder cannot be deleted. Stock report can be deleted.

Delete
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DescriptionAction

Assigns appropriate permissions to access and manage the Report.

Groups—Grants View and Edit permissions for the Report.

• Security Administrators can grant these permissions to various groups.

• Entity owners can grant these permissions to groups that they are directly
associated with.

Users—Grants View and Edit permissions for the Report to various users.
Applicable only to Security Administrators.

Note • Higher permissions (View and Edit) from either an individual
user or the user group takes precedence.

• Only the first 200 records (alphabetical order) are displayed in
the Members or Groups panel. To view more records, see
Configure > Groups.

• When you modify a permission and want to switch between
Groups and Users tabs, you will be prompted to either save or
discard the changes.

Permissions

Displays the Report permalink. For more information, see Permalink for a Report.

You can access permanent hyperlink only from a web browser.Note

Permalinks

Export any custom report or report folders. Reports and report folders are exported
in a ZIP file format. To export a report or a report folder, you need the REPORT
DESIGNER role. For more information, see Export Reports and Folders.

Export

Related Topics
Permalink for a Report, on page 46
Add Template Help, on page 19
Create Reports
Import Reports, on page 37
Export Reports and Folders, on page 38
Report Filters, on page 20

Add Template Help
You can configure individual help files to each Cisco Unified Intelligence Center report. You can either host
the help page separately and point the report to it or create and upload the help page along with the report.

This help content is specific to the report and can contain explanation on:

• How to use the report

• Field description

• Details of the relationship between the fields
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• How to interpret the report data or

• Any other report related information

You can upload only files in ZIP formats. ZIP files can contain multiple HTML files. The HTML page contents
support rich text including images.

Help files does not support videos and other interactive content.Note

To configure the help page for a report, perform the following steps:

Procedure

Step 1 From the left navigation pane, click Reports.
Step 2 Click the Ellipsis icon (…) next to the report row for which you want to create the help page and click Add

Help.
Step 3 In the Add Help dialog box,

• If you want to set an external help page as the report help, select the URL option and enter the external
URL location.

• If you want to upload the help file, select the Choose file option and click Browse to upload a ZIP file
(with HTML files).

Step 4 After uploading the file, click Save.

When you run the report, click the "?" icon (Template Help) on the Reports toolbar to view the
configured help file.

Note

Related Topics
Get Help on a Report, on page 55

Report Filters

Filter Types
Report filters in Unified Intelligence Center are used to present selective data. You can define the filter to
filter the data that you want to display in the report. There are two ways to view the Filter page.

• Before the report is generated: You can set and refine the default filter values using the Actions > Set
Default Filter option.

• After the report is generated: You can refine the filter values using the filter icon.
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You cannot view filters if the Report Designer has selected the Skip filter during
the report processing check box during the report filter selection.

Note

Cisco Unified Intelligence Center supports the following types of report filters:

• Date & Time

• Key Criteria

• Field Filters

• Parameters

Filter parameters are displayed based on the selected query type in the Report Definition for that report.

Table 4: Filter tabs

Applicable Filter TabsReport Definition Query Type

Date & Time, Key Criteria, Field FiltersDatabase Query

Key Criteria, Field FiltersLive Data or Real Time Streaming

ParametersAnonymous Block

ParametersStored Procedure

Date & Time

• Cisco Unified Intelligence Center uses the browser locale to display the Date & Time format in the filter
page. If Cisco Unified Intelligence Center does not support the browser locale language, then the locale
selected in the Cisco Unified Intelligence Center application is used.

Note

To configure Date and Time filters for a report, perform the following steps:

Procedure

Step 1 After creating the report, click Set Default Filter from the ellipsis Actions.
Step 2 In the Date & Time filter wizard, select the Date Range and Time Range options.

• The options available in the Date Range and Time Range filter are predefined.

• Selection of the Custom option allows you to customize the Date Range and Time Range details.

You can select the days of the week (Days > Custom) only if the time interval spans more than a day.
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For reports that are based on the query type Anonymous Block, you cannot select days of the week. For
more information, see Cisco Unified Intelligence Center Report Customization Guide at
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-intelligence-center/products-user-guide-list.html.

Step 3 Check the Skip filter during the report execution check box if you want to skip filter selection during the
running of report.

In the Choose Filter dialog box (report run mode), you can check the Set as Default check box
to set the report filter as the default.

Note

Step 4 Click Next.

Key Criteria
Use theKey Criteria tab in the filter to select value lists or collections. A collection is a pre-configured group
of values.

Key Criteria fields are predefined filters and are displayed in the filter screen if they are defined in the Report
Definition.

Note

To configure Key Criteria filters, perform the following steps:

Procedure

Step 1 After creating the report, click Set Default Filter from the ellipsis Actions.
Step 2 In the Date & Time filter wizard, select the Date Range and Time Range options and click Next.
Step 3 In the Key Criteria filter wizard, select the collections or values from the Available selection box.

Do not set multiple filter parameters; set any one filter parameter.Note

Step 4 Use the arrows to move the selected collections or values to the Selected selection box.
Step 5 You can also select multiple collections or values.
Step 6 Click Next.

Field Filters
Use the Field Filters tab to filter any field in the report. Based on the selected field type (date, numeric/decimal,
boolean, or string), different operators are available. For example, you can filter calls in queue for greater
than two minutes or on all agents in the hold state to filter out the less important information.
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You can configure Field Filters in reports:

• Only for SQL Query based reports.

• To filter a text, date, boolean, or a decimal field.

Note

To configure Field Filters, perform the following steps:

Procedure

Step 1 After creating the report, click Set Default Filter from the ellipsis Actions.
Step 2 In the Date & Time filter wizard, select the Date Range and Time Range options and click Next.
Step 3 In the Key Criteria filter wizard, select the collections or values from the Available selection box and click

Next.
Step 4 In the Field Filters wizard, select the filter according to the following criteria.

Filter criteria/operators depend on the selected field type (date, numeric/decimal, boolean, or string).

• For Date, the options available in Date Range filter are predefined. Using the Date Range drop-down
list, select from Custom, Today, Yesterday, This Week, Last Week, This Month, Last Month, Year to
Date, or Last Year.

Only Custom will allow the user to customize the Calendar, Time Range and Days certain days of the
week.

• For Decimal, select an Operator from Equal To, Not Equal To, Less Than, Less Than or Equal To, or
Greater Than and then enter a value; for example, Operator = Greater Than and Value = 16.5.

• For String, select an Operator from Equal To, Not Equal To, or Matches and then enter a value for the
string; for example, Operator = Matches and Value = Team Green.

• If you select Matches as the Operator, you must specify an SQL pattern to match the string field.
The system appends the wild card character % automatically to the beginning and end of the string.
You can also use any SQL wild card pattern in between the string.

• If the filter field is associated with a Value List, then specify any value or move one, all, or some
items in the list to the Selected column to filter.

Use only theMatches operator to filter the report data records with leading or trailing spaces.
Do not use the Equal To or Not Equal To operators in such scenarios as Unified Intelligence
Center trims the filter criteria before running the SQL query and hence does not fetch the
matching results.

Note

• For Boolean, select True or False from the Operator list.

Step 5 Using the Operator drop-down list, select the criteria.

If you select Matches operator, you can use any Microsoft SQL wildcard pattern to filter the
data. The wildcard character % is added to the beginning and end of every string that is used to
filter the data.

Note
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Step 6 In the Value field, enter a value against which the data in the field will be filtered.
Step 7 Click Run.

Report Types
There are three types of reports based on the query types:

• Historical report

• Real-time report

• Live Data report

Report Components

These reports consist of the following components:

• Data Source

The Data Source defines the sources that contain the data for the report. Unified Intelligence Center
supports three types of data sources: Microsoft SQL Server, IBM Informix, and Streaming. The data
source should be pre-configured for you. If it is not, contact your administrator to configure the appropriate
data source.

• Report Definitions

Each report has a Report Definition, which represents how data is retrieved from the data source for that
report template. In addition to specifying how data is retrieved (by a simple MS SQL query, stored
procedure query, real time streaming or an anonymous block query), a report definition contains the
dataset that is obtained. This includes the fields, filters, formulas, refresh rate, and key criteria field for
the report.

• Reports

Reports show data returned by Report Definitions. This data is extracted by database queries.

• Time Zone Conversions

The time zone conversion happens if there is a difference between the user and the data source time
zones.

Daylight savings time consideration for Database Query Reports: The Daylight savings time offset
at the start of the date range is considered for the time zone conversion when the report is filtered. If the
daylight savings change occurs somewhere in between the filter date and time ranges, the time zone
offsets will not be computed properly if the user and the data source are in different time zones. In this
case, you will have to split the time filter such that separate report invocations are run before and after
the daylight savings time change.

The daylight savings time offset depends on the latest system time zone library.Note
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Daylight savings start date or end date may (when the data is recorded) create an
additional row (in the report output) due to the time zone value change in the
SQL database. This applies to any template report, as well as for any query type
(Anonymous block, Database Query, Stored Procedure, Real Time Streaming)
that these template reports would use. For confirmation that SQL had time zone
value change, use the Report Options icon from the report summary page and
run the SQL command in AW node to validate the change in the time zone.

Note

Example 1:

User time zone: Australia/Sydney

Data source time zone: America/New_York

Daylight savings time changes: +1 hour for Sydney at 2013-10-06 02:00
a.m. DST +1 hour is already on for New York

Filter selected by the user: 2013-10-06 to 2013-10-06, 12:00 a.m. to
11:59 p.m.

Query formed in data source time zone: 2013-10-05 10:00:00 a.m. to
2013-10-06 09:59:59 a.m.

Report displayed in user time zone: 2013-10-06 12:00 a.m. to 2013-10-07
12:59 a.m.

In this case, the report will display an extra hour of data as Sydney Daylight savings time is off at the
start of the date range and on at the end of the date range.

Example 2:

User time zone: Australia/Sydney

Data source time zone: America/New_York

Daylight savings time changes: +1 hour on for Sydney at 2013-10-06
02:00 a.m. DST +1 hour is already on for New York

Filters selected : 2013-10-06 to 2013-10-10, 03:00 a.m. to 11:59 p.m.

Query formed in data source timezone: 2013-10-05 12:00:00 p.m to
2013-10-06 08:59:59 a.m.

Report displayed in user time zone: 2013-10-06 03:00 a.m. to 2013-10-06
11:59 p.m.

In this case, the conversion happens as expected as there is no Daylight savings time change in between
the date ranges.

Example 3:

User time zone: America/New_York

Data source time zone: IST

Daylight savings time changes: +1 hour DST at 2013-03-03 02:00 a.m.
and off at 2013-11-03 02:00 a.m. for New York. No Daylight savings
time changes for IST.

Cisco Unified Intelligence Center User Guide, Release 12.5(1)
25

Reports
Report Types



Filter selected by the user : 2013-11-03 to 2013-11-03, 01:30 a.m. to
05:30 p.m.

Query formed in data source time zone: 2013-11-03 11:00:00 a.m. to
2013-11-03 02:59:59 a.m.

Report displayed in user time zone: 2013-11-03 01:30 a.m. to 2013-11-03
04:30 p.m.

In this case, the report will display one hour less of data as New York Daylight savings time is on at the
start of the date range and off at the end of the date range.

• Report Views

A report can be presented in multiple formats (grid and charts). Each view can have its own set of fields.
A single report can have multiple views.

• Report Help

You can attach a help page specifically for your report. For more information, see Add Template Help.

Related Topics
Add Template Help, on page 19

Historical and Real Time Reports
Historical report—Retrieves data from the historical data source. Reports are populated with interval data
that has a default refresh rate of 15 minutes. Historical reports have an upper limit of 8000 rows.

Real-time report—Retrieves data from the real-time data source. Reports are populated with interval data
that has a default refresh rate of 15 seconds. Real-time reports have an upper limit of 3000 rows.

While running Cisco Unified Intelligence Center Historical and Real-Time Reports you can:

• Filter data in a report

• Change the view of a report from a grid to a gauge or a chart

You can select one of the predefined grid, gauge, or chart views.

For more information on creating/editing views, see Report Views.

Note

• Modify reports

Related Topics
Report Views, on page 28

Live Data Reports
Live Data report—Receives data from streaming data source. Live Data reports supports only grid view.
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Live Data reports do not automatically respond to changes in the system time. If the server or client time is
changed or adjusted, the report must be refreshed to accurately display the duration field values. For example,
during a daylight saving time (DST) change, active live data reports do not display correct values in the
duration field. Live data reports must be refreshed to update.

Note

Manage Reports

Create Reports
All actions on the Reports interface are based on user role and on the user's object permissions for reports and
for categories.

By default, reporting users do not have permission to create a subfolder in Reports. An Administrator can
create a subfolder and grant access.

Note

To create a new report, perform the following steps:

Procedure

Step 1 In the left navigation pane, choose Reports.
Step 2 Navigate to the folder where you want to create the report.
Step 3 From the Reports toolbar, click New > Report.

To edit an existing report, navigate to the report, click the ellipsis icon beside the report and click Edit.

Step 4 In the Create New Report window, enter the Report Name and Description.

The report name must be unique to Cisco Unified Intelligence Center.Note

Step 5 Click Next.
Step 6 In the Basic Details tab, enter or select the report details.

Use the arrows to select the appropriate Report Definition.Note

Step 7 Click Next.
Step 8 In the Manage Views tab, create the report views and click Next.

For more information, see Report Views.

Step 9 In the Thresholds tab, create report thresholds and click Finish.

For more information, see Report Thresholds.
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The newly created report is listed in the Reports page.

Related Topics
Report Filters, on page 20
Report Views, on page 28
Report Thresholds, on page 32

Report Views
There are two types of report views:

• Grid View

• Chart View

Do not delete the Report Definition fields that are currently associated with any of the manually created report
views. If deleted, you must reapply the Data Fields for all the manually created report views to save the report.

For default grid views, the deleted field is removed automatically from the Data Fields list retaining any other
fields in the Selected Field list. Hence, no additional action is required to save the report.

Note

Create a Grid View
Grids are tabular presentations of the data in rows and columns. By default, all Cisco stock reports have a
grid view. For custom reports, a default grid is created from the SQL query in the Report Definition.

Grouping and font size is not supported in Live Data reports.Note

You can create a Grid View while creating or editing a report.

To create a Grid View, perform the following steps:

Procedure

Step 1 Create or edit a report.
Step 2 Enter the report details in the Basic Details screen and click Next.

The Manage Views screen appears with a default grid view.

You can access Report permalinks only after completing the report creation. Report permalinks
allow you to share your report with other users and view reports of other users. For more
information, see Permalink for a Report.

Note

Step 3 You can edit the default view (Actions column > Edit View) or click Create New > Grid view to create a
new grid view.

The Edit Grid View or the New Grid View screen appears depending on your selection for edit or create.
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Step 4 Enter the Name and Description in the respective fields.

Maximum length allowed for the grid view Name: 50 characters.Note

Step 5 From the Font selection box, you can select the font size from the list to display the grid data.
Step 6 Use the arrow buttons to select fields from the Available value list box to move to the Selected field list.
Step 7 You can use the following features to improve grid view display:

• Header—Use this feature to add (+) or delete (-) a header for the selected fields. This helps in categorizing
the field set.

You cannot save the view with empty headers.

Post upgrade to Cisco Unified Intelligence Center 12.0 or later, any empty headers that exist
in the report views in prior releases are not migrated.

Note

• Edit icon—In the Selected value list box, click the Edit icon (hover on the field value) if you want to
edit the Display Name and Column Width for the selected field and click Done.

For Header fields, you can only edit the Display Name.Note

• Sort Grid by Field—Select the Sort Grid by Field check box to sort the selected report columns in
eitherAscending orDescending order. Selecting this check box enables the drop-down list to be populated
with the values from the Selected value list box. You can select only one value for sorting.

Step 8 Click Save.
The Report Views screen appears.

Step 9 Click Finish.

Create a Chart View
Cisco Unified Intelligence Center supports the following chart types:

• Bar—Bar charts display discontinuous events and show the differences between events rather than trends.
Bar charts are oriented vertically and can be stacked horizontally or clustered one below the other.

• Pie/Donut—Pie charts display quantities as proportions of a whole. The circle (pie) represents 100% of
the data, with each quantity represented as a wedge of the appropriate size. Pie charts take decimal or
numeric fields only. A pie chart cannot have more than 50 wedges. An error occurs if your data set and
chart editor selections generate a pie chart with more than 50 wedges.

A doughnut chart is another display representation of a pie chart.

• Column—Column charts display discontinuous events and show the differences between events rather
than trends. Column charts are oriented horizontally and can be stacked vertically or clustered side by
side.

• Dial Gauge/Numeric—A gauge chart displays the dial representation of the report results as per the
defined threshold.

The Numeric chart displays the report results in a number format highlighted as per the defined threshold.

• Line charts—Line charts display continuous quantities over time against a common scale. Use the Line
charts to show trends.
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• Live Data reports do not support chart view.

• In the vertically oriented charts, for Cyrillic characters, the data labels in the Horizontal Axis field may
be hidden or garbled. This is a known limitation. Hence, for Cyrillic characters, use the horizontally
oriented charts.

Note

To create a Chart View, perform the following steps:

Procedure

Step 1 Create or edit a report.
Step 2 Enter the report details in the Basic Details screen and click Next.

The Manage Views screen appears with a default grid view.

You can access Report permalinks only after completing the report creation. Report permalinks
allow you to share your report with other users and view reports of other users. For more
information, see Permalink for a Report.

Note

Step 3 Click Create New > Chart view.
Step 4 In the Create New Chart View screen, click the required chart type. For more information, see Chart Types.
Step 5 Enter the Chart Information; Name, Description and click Next.

Maximum length allowed for the chart view Name: 50 characters.

For Cartesian type charts (Bar, Column, and Line), select the Group Data check box to group
data:

• By a field—Select this option to create a chart view where the vertical axis shows fields
with footer formula configured for line or column chart and horizontal axis with footer
formula for bar chart.

• By label field—Select this option to create a chart view where the vertical axis shows fields
of decimal data type for Line or Column chart. In Bar chart, the horizontal axis shows fields
of decimal type.

Note

For Pie charts, you can only Group Data by Label Field.Note

Step 6 In the Add Data Fields screen, select the Label Field from the drop-down list and Data Fields from the list
box and click Next.

Step 7 In the Preview and Format screen, enter or select appropriate information based on the selected chart type.

For more information, see Chart Types.

For the following Data Fields, the Column Type (Stacked and Grouped) feature is unavailable.

• Date and Time

• Boolean

Note
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Step 8 Click Save.

Related Topics
Permalink for a Report, on page 46
Chart Types, on page 31

Chart Types

Preview and FormatAdd Data FieldsChart
Information

Chart Type

YesYesYesBar

YesYesYesColumn

YesYesYesLine

Yes

You can select Dial Gauge or Numeric view
for this report.

To set the chart view for Dial Gauge/Numeric,
perform the following steps:

1. Enter the Range (min and max). Default:
0-100

2. Define the zones.

When the chart value is within any of the
defined thresholds,

• The gauge pointer points to the
corresponding color set in the
threshold.

• The Numeric text is displayed in the
corresponding color set in the
threshold.

3. Click Save.

Yes

To
configure
a Gauge
chart,
Report
Definition
must have
at least one
decimal
field with
footer
configured.

Note

NoGauge/Numeric
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Preview and FormatAdd Data FieldsChart
Information

Chart Type

Yes

You can select Pie orDonut as the display type
for this report.

Yes

To
configure
a Pie chart,
Report
Definition
must have
at least one
decimal
field
configured.

Note

YesPie

Report Thresholds
You can set a threshold indicator for a field to display if the field value meets the threshold condition. There
are nine colors instead of the color palette for the threshold color selection in this release. Threshold indicators
can be set only for view type Grid and Chart > Gauge.

For setting field threshold indicators for a Chart > Gauge view, see Create a Chart View.

For setting field threshold indicators for a Grid view, perform the following steps:

Procedure

Step 1 From the Manage Views screen, after adding the report views, click Next.
The Thresholds screen appears.

Step 2 Select a view to which you want to set the threshold and select the field name from theCreate new threshold
list.
The screen refreshes with a new panel for the selected field name.

Step 3 Select a field operator and set a condition from the Operator list.
DescriptionOperator

The Matches operator accepts Regular Expressions.Matches

Note that the Regular Expressions does not support:

• Flags (i, g, m, n, y), OR/AND any combinations of these flags.

• Leading and trailing forward slash (/).

Example:

• Valid Pattern→ \w+\s

• Invalid Pattern→ /\w+\s/g

(As it contains leading and trailing forward slash (/) and a "g" flag.)
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DescriptionOperator

In Report Definition, if the %format is defined for any field, then while setting the
thresholds for that field, ensure to enter the decimal format of the percentage to render
the condition in the report.

String fields;
Always, Equal,
Not Equal

For example:Decimal fields;
Always, Equal, In Report Definition, if %format is defined for the field "SL" (Service Level) and you

want to apply thresholds to this field to indicate "Red" if SL is less than 60%, set the
following:

Not Equal,
Greater Than,
Less Than,
Greater Than a. Define the threshold for the SL field.
Equal To, Less

b. Set the Operator to Less Than.Than or Equal To,
Between c. Enter the percentage value as 0.60.

d. Select “Red” in the No Fill drop-down.

e. Click Done.

Step 4 Choose the options from No Fill and edit the threshold fields.

You can set conditions on the same or different fields:

• condition on same field: threshold and condition on the same field.

• condition on different field: threshold for a field, based on the condition on the different
field.

• multi conditions on same field: apply threshold for a field based on the condition on different
fields.

Note

When you upgrade to Unified Intelligence Center version 11.6 or later, all the threshold colors
are retained for reports that are created in the earlier versions. But, when youmodify the threshold,
all the old threshold color selection are lost within the report. Hence, you must reconfigure the
threshold color selection for that report.

Caution

For existing reports, perform the above mentioned steps to add more thresholds.

Threshold configuration supports upto 30 thresholds for a field.Note

To edit an existing threshold from a report run already, clickReport options and selectManage Thresholds.

Step 5 Format the text in the field to appear when it matches the threshold condition. Use the following options:

• Text Bold—Select this check box to highlight the report field in bold.

• Text/Background Color—Select a color from the drop-down for the text/background color in the field.

• Text Substitute—Enter a new string if you want the text in the field to be replaced with it when it matches
the threshold condition.

• Syntax to add an html hyperlink as text substitute: <a href=https://www.cisco.com
target=_blank>cisco</a>
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• Syntax to add an empty space as text substitute: &nbsp;

• Image Location—Enter the URL path of the image if you want the text to be replaced with an image.

Supports only image URLs reachable from Unified Intelligence Center server. Maximum
size limit allowed for the image is 5MB.

Note

Step 6 Click Done.
Step 7 Click Finish.

Related Topics
Create a Chart View, on page 29

Run Report

Report Actions - Run Mode
The following table lists all the menu items and actions you can perform when you run a report.

Table 5: Report Actions

DescriptionAction

Report options

Displays the Edit View dialog box. You can modify the current report view and
click Done to instantly view the modified view.

Edit View

Clones the existing report view. In the Save View dialog box, enter the Name and
Description for the cloned view and click Save. The executed report page refreshes
with the cloned view.

Save View As

For the executed report, you can directly create a chart view if you have Edit
permissions. After you create the chart view, the executed report page refreshes
with the newly created chart view and gets listed in the view list.

This feature is disabled for Live Data reports.Note

For more information, see Create a Chart View.

Create Chart View

Add/remove/update grouping configurations for the current view (columns). Cisco
Unified Intelligence Center grid reports support up to three levels of grouping.

If you are grouping the column with Date or Date time data type, you can group
records on a Daily/Weekly/Monthly basis.

For more information, see Group By.

Group By

Sets a threshold indicator for a field to display if the field value meets the threshold
condition. Threshold indicators can be set only for views of type Grid and Gauge.

For more information, see Report Thresholds.

Manage Thresholds
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DescriptionAction

Displays the SQL code used to execute this report.SQL

Exports the executed grid report data into your local disk in a .xlsx format.

Note • When you export a report to an Excel file format, to read the
exported report, the client system’s locale must match with the
browser’s locale (where you had exported the report).

• When reports are exported to Excel in Report viewer, the custom
formatting of DECIMAL data type is not applied.

Export

Report menu

Click to run or pause the report respectively.

Report execution times out after three minutes. Rerun the report by
modifying the filter, and if the problem persists, contact your
administrator.

Note

Run or Pause the report

Prints the report using your default printer.

Reports in chart view supports only landscapemode in A3 size paper
for printing.

Note

Print Report

Displays Choose Filter dialog box to modify filter criteria for this report.

For more information, see Report Filters.

Manage Filters

Refreshes the Report page.Refresh

Displays the filter information of the executed report.View Filter Information

Displays the configured template help. You can configure template help for the
report from the Reports page > Add Help.

For more information, see Add Template Help.

Online Help

Enable this toggle button to view only rows with matching threshold values in the
report.

By default, this check box is unchecked for every report.

This button is disabled for the grouped view.Note

Only Thresholds

Group By
For a report that is run, use theGroup By option to add/remove/update grouping configurations for the current
view. Cisco Unified Intelligence Center grid reports support up to three levels of grouping.

If you’re grouping the column with Date or Date Time data type, you can group records on a
Daily/Weekly/Monthly basis.
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• Live data reports don’t support grouping.

• Grouped fields cannot be hidden.

Note

To group the report data, perform the following steps:

Procedure

Step 1 From the report that is run, click the Report options icon and select the Group By option.
Step 2 In the Group By dialog box, specify the Number of Levels you want to group the report.

Depending on the number of levels selected, the Level, Grouped By, Sub Group, and Show Expanded columns
are activated.

Cisco Unified Intelligence Center grid reports support up to three levels of grouping.

Step 3 To group the report data by values in a particular column, select the required column name from theGrouped
By list.
If you select a date or date and time value from the list, you can select any one of the following from the Sub
Group column:

• None—The report data is grouped by the absolute date or date time values.

• Daily—The report data is grouped by day.

• Weekly—The report data is grouped by week.

• Monthly—The report data is grouped by month.

By default, the Show Expanded option is selected and you can uncheck the option if necessary. The Show
Expanded column allows you to view the reports that are run with the group expanded.

Enable the Show Summary Only toggle button to display only the summary row in the report.

For example, if you group by Agent Team and enable the Show Summary Only toggle button, only the
summary data row for each team is displayed.

If any of the fields have a footer formula defined in the report definition, then a group level
summary is also displayed for such fields using that formula.

Note

Step 4 Click Save.

• For the grouped view, the Only Thresholds check box is disabled.

• Thresholds aren’t displayed in a grouped field and on summary rows.

• You cannot perform a drill-down from a report with grouped fields.

Note
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Import Reports
You can import the Unified Intelligence Center report, which is in either .xml or .zip file format.

The imported report retrieves data for the following entities:

• Report

• Report Definition

• Value Lists

• Views

• Thresholds

• Drilldowns

• Template Help

Each report template help folder has a size limit of 3MB. If the folder size exceeds
this limit, the system does not load the help content.

Note

You cannot import Report Filters and Collections.Note

To import reports, perform the following steps:

Procedure

Step 1 In the left navigation pane, choose Reports.
Step 2 In the Reports listing page, click Import.
Step 3 Click Browse to select the file (.xml or .zip format) to be imported.

Maximum file size for .zip file format is 60 MB and for .xml file format is 3 MB.Note

Step 4 Select the required file and click Open.
Step 5 Select the file location from the Save to Folder list to save the file.
Step 6 Click Upload.

Once the file is successfully uploaded, the table gets populated with the corresponding report template, current
available version, and incoming version of the files being imported.

Step 7 Select a Data Source for the Report Definition only if the Report Definition for the report being imported is
not defined in Unified Intelligence Center.

Step 8 Select a Data Source for the Value List that is defined in the Report Definition.
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Selection of a Data Source for the Value List is mandatory:

• If the Value List does not use the same Data Source as the Report Definition.

• For Real Time Streaming Report Definitions.

Note

Step 9 Select the files to import or overwrite.

• Overwrite—If the report being imported exists in the Unified Intelligence Center.

• Import—If the report being imported is the new set of report files.

Step 10 Click Import.

• If the system does not have report definitions, new report definitions are created in Report
Definitions > Imported Report Definitions folder.

• Importing a report to a different version of Unified Intelligence Center is not supported.
However, when you upgrade Unified Intelligence Center, report templates continue to work
in the upgraded version.

• Importing manually edited XMLs is not supported.

Note

Export Reports and Folders
You can export any custom or stock report or report folders from the Unified Intelligence Center. Reports
and report folders are exported in a ZIP file format.

When you export a folder, the reports in the folder are grouped as ZIP files. The grouping is based on the data
source that is used by the report definition and the value lists.

• For customized reports, you must update the version numbers of the value list and report definition before
you export the report. Else, the export will not overwrite the existing reports.

• While exporting folders, ensure that all the Value Lists in the report definitions or folders point to the
same data source respectively.

Note

Do not modify the exported report (XML file) for customization purposes. However, if necessary, you can
modify only the EntityVersion of the Report, Report Definition, and ValueList.

Caution

When you export a report, the following data that is associated with the report are exported:

• Report

• Report Definition

• Value Lists
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• Views

• Thresholds

• Drilldowns

• Template Help (if not bundled, an empty folder is created in the zip file)

Report Filters and Collections are not exported along with the report.Note

To export a report or a folder, perform the following steps:

Procedure

Step 1 From the left navigation panel, click Reports.
Step 2 Navigate to the report or the report folder that you want to export and click the ellipsis icon beside the report

and click Export.

If necessary, you can rename the report or the report folder. Do not change the file extension
(Reports or report folder: zip).

Note

Step 3 Click OK.
The exported file is downloaded into your specified local folder.
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C H A P T E R 4
Report and Time zones

• Reports and Time Zones, on page 41

Reports and Time Zones
You can configure four time zones in Unified Intelligence Center: Server, Data Source, Report and User.

Server

The server time zone is defined during installation while running the installation wizard and it does not affect
reports. The server administrator can view and change the server time zone using these CLI commands: show
timezone config and set timezone zone. For more information, see Administration Console User Guide
for Cisco Unified Intelligence Center at: https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-intelligence-center/products-maintenance-guides-list.html

Data Source

The data source time zone is defined when the data source is configured. It is the time zone of the database.

Report

The report time zone is defined in the report filter.

If your call center spans several time zones and you intend to compare reports, run historical reports using
the absolute date range and a specific time period.

User

The user's time zone is set on the User Profile.

For example, when a user in New York is asked to review a report that was run by a colleague in the China
office, the user accesses the User Profile page to change the time zone to match the colleague's, and then runs
the report using the same absolute date range.

Time Zone Considerations

The system treats the time-specific data that the user enters as local to the user's time zone and then converts
this time to the data source time zone when the filter query is formed.
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The system treats the time-specific data that it fetches from a data source as local to the data source and then
converts this time to the user time zone before displaying the date and time in the report data.

If the user time zone or data source time zone is not configured, the system uses the time zone of the Unified
Intelligence Center server. The system performs these conversions only after the time zone normalization at
data source level has occurred.

The schedule for Weekly and Monthly reports is based on the data source time zone, not the server time zone.
That is, the week and month boundaries are midnight, in the time zone of the database, of the week or month
beginning and end days.

Note

Consider the following example, in which the user enters the date and time value in the filter. Depending on
the time zone setting, the system converts the time zones in the filter query as shown below:

filter value = 1/1/2010 12:00:00 AM

Data Source Time ZoneData Source Time ZoneUser Time ZoneUser Time Zone

When not set (Add Cisco
Unified Intelligence
Center server time zone)

When set (+2 GMT)When not set (Subtract
Cisco Unified Intelligence
Center server time zone)

When set (+11 GMT)

Thursday, December 31,
2009 6:30:00 PM IST

Original Time – User time
zone offset (+11 GMT) +
CiscoUnified Intelligence
server time zone (+5.30
GMT)

From Original Time, 5.30
( –11 +5.30) hours
subtracted

Thursday, December 31,
2009 3:00:00 PM EET

Original Time –User time
zone offset (+11 GMT) +
Data source time zone (+2
GMT)

To Original Time, -9 ( -11
+2) hours added

Thursday, December 31,
2009 8:30:00 PM EET

Original Time – Cisco
Unified Intelligence
server time zone (+5.30
GMT) + Data source time
zone offset ( +2 GMT)

From Original Time, 3.30
(– 5.30 +2) hours
subtracted

Thursday, December 31,
2009 3:00:00 PM EET

Original Time –User time
zone offset (+11 GMT) +
Data source time zone (+2
GMT)

To Original Time, -9 ( -11
+2) hours added

Friday, January 1, 2010
12:00:00 AM IST

To Original Time, 0 (–
5.30 +5.30) hours added

Thursday, December 31,
2009 8:30:00 PM EET

Original Time – Cisco
Unified Intelligence
server time zone (+5.30
GMT) + Data source time
zone offset ( +2 GMT)

From Original Time, 3.30
(–5.30 +2) hours
subtracted

Friday, January 1, 2010
12:00:00 AM IST

To Original Time, 0 (–
5.30 +5.30) hours added

Thursday, December 31,
2009 6:30:00 PM IST

Original Time –User time
zone offset (+11 GMT) +
CiscoUnified Intelligence
server time zone (+5.30
GMT)

From Original Time, 5.30
( –11 +5.30) hours
subtracted

The following example shows a database with date and time values. Depending on your time zone setting,
the system converts and displays the time zones in the report data as shown below:

Database value = 1/1/2010 12:00:00 AM

User Time ZoneUser Time ZoneData Source Time ZoneData Source Time Zone
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When not set (Add Unified
Intelligence Center server
time zone)

When set (+2 GMT)When not set (Subtract
Unified Intelligence
Center server time zone)

When set (+11 GMT)

Thursday, December 31,
2009 6:30:00 PM IST

Original Time – Data
source time zone offset
(+11 GMT) + Unified
Intelligence Center server
time zone (+5.30 GMT)

From Original Time, 5.30
( –11 +5.30) hours
subtracted

Thursday, December 31,
2009 3:00:00 PM EET

Original Time – Data
source time zone offset
(+11 GMT) + User time
zone (+2 GMT)

To Original Time, -9 ( -11
+2) hours added

Thursday, December 31,
2009 8:30:00 PM EET

Original Time – Unified
Intelligence Center server
time zone (+5.30 GMT) +
User time zone offset ( +2
GMT)

From Original Time, 3.30
(– 5.30 +2) hours
subtracted

Thursday, December 31,
2009 3:00:00 PM EET

Original Time – Data
source time zone offset
(+11 GMT) + User time
zone (+2 GMT)

To Original Time, -9 ( -11
+2) hours added

Friday, January 1, 2010
12:00:00 AM IST

To Original Time, 0 (–
5.30 +5.30) hours added

Thursday, December 31,
2009 8:30:00 PM EET

Original Time – Unified
Intelligence Center server
time zone(+5.30 GMT) +
User time zone offset ( +2
GMT)

From Original Time, 3.30
(–5.30 +2) hours
subtracted

Friday, January 1, 2010
12:00:00 AM IST

To Original Time, 0 (–
5.30 +5.30) hours added

Thursday, December 31,
2009 6:30:00 PM IST

Original Time – Data
source time zone offset
(+11 GMT) + Unified
Intelligence Center server
time zone (+5.30 GMT)

From Original Time, 5.30
( –11 +5.30) hours
subtracted
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C H A P T E R 5
Permalinks

• Overview, on page 45
• Permalink for a Dashboard, on page 45
• Permalink for a Report, on page 46
• View Report Permalinks in Dashboards, on page 48

Overview
Permalinks in Cisco Unified Intelligence Center are permanent hyperlinks.

Unified Intelligence Center supports the following types of permalinks for reports:

• Excel Link: This permalink is generated only for grid view.

• HTML Link: This permalink is generated for grid view, gauge view, and chart view.

• XML Link: This permalink is generated only for the grid view. It is used where the data is required in
XML format.

For Live Data reports, you will only have the HTML permalink. HTML permalink for Live Data reports
always require authentication.

Note

Due to security reasons, permalinks from one Unified Intelligence Center cannot be displayed in the dashboard
of another Unified Intelligence Center instance.

Note

Permalink for a Dashboard
Dashboard permalinks help you to share your Dashboards with other users and view Dashboards of other
users.
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• You can access the Dashboard permalink only from a web browser.

• Authenticated Dashboard permalinks are not supported in Cisco Finesse.

• When an unauthenticated Dashboard permalink is accessed in an authenticated browser session, access
to the permalink is controlled by the logged in user's permissions.

Note

To view the Dashboard permalink, perform the following steps:

Procedure

Step 1 From the left navigation pane, click Dashboards.
Step 2 Click the ellipsis icon beside the required Dashboard and click Permalinks.
Step 3 In the Permalinks dialog box, click HTML to display the Dashboard permalink in the Link text box.

• By default, all Dashboards are authentication enabled. When the Authenticate Permalink
check box is enabled, users accessing the permalink are prompted to enter their credentials
to view the Dashboard.

• When you uncheck theAuthenticate Permalink check box for a Dashboard, users can view
that Dashboard using the permalink, without authentication.

Sharing an unauthenticated permalink of your Dashboard shares even the authenticated
report permalinks added into the Dashboard.

• For Dashboards that contain Live Data report, ensure to select theAuthenticate Permalink
check box.

Note

Step 4 Copy and paste the permalink in any browser to view the Dashboard.
Step 5 Click Save.

Permalink for a Report
Report permalinks help you to share your report with other users and view reports of other users.

• Authenticated report permalinks are not supported in Cisco Finesse.

• Authenticated Excel report permalink is not supported in SSO.

• Authenticated Excel report permalink is not supported on Office 365.

• When an unauthenticated Report permalink is accessed in an authenticated browser session, access to
the permalink is controlled by the logged in user's permissions.

• You cannot drill down to another report from a report permalink.

Note
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To view the Report permalink, perform the following steps:

Procedure

Step 1 From the left navigation pane, click Reports.
Step 2 Click the ellipsis icon beside the required Report and click Permalinks.
Step 3 In the Permalinks dialog box, select from the available Link formats; HTML, Excel, XML to display the

corresponding Report permalink in the Link text box.

• By default, theAuthenticate Permalink check boxes are checked to indicate that the default
and variable permalink are authenticated.

• For Live Data reports, by default, the Authenticate check box is checked and disabled.

Note

Step 4 To view the report,

• HTML and XML Permalink—Copy and paste the permalink (HTML and XML) in any browser

• Excel Permalink—

• To import permalinks in Excel, use the permalinks with FQDN only.

• To embed excel permalink content as external data within excel on macOS, add tomcat
certificate from Certificate Management to the trust store of macOS in case self-signed
certificates are being used.

Note

Excel—

a. Access Excel and navigate to Data > From Web.

b. In the New Web Query > Address field, paste the report permalink and click Import.

Excel 365—

a. Access Excel 365 and navigate to Data > From Web.

b. In the From Web > URL field, paste the report permalink and click OK.

For the first time, you will be prompted to Connect in the Access Web Content dialog
box.

Note

c. In the Navigator dialog box, click Table View > Load.

Step 5 Click Save.

For information on viewing report permalinks in Dashboards as web page widgets, see View Report Permalinks
in Dashboards.

For more information on permalinks, see Cisco Unified Intelligence Center Report Customization Guide at
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-intelligence-center/products-user-guide-list.html.
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Related Topics
View Report Permalinks in Dashboards, on page 48

View Report Permalinks in Dashboards
Viewing report permalinks in Dashboards as web page widgets depends on the authentication status of both
reports and the dashboards. The following matrix provides different scenarios that supports viewing report
permalinks in Dashboards.

Un-Auth
Report
Permalink
Different
Cluster

Un-Auth
Report
Permalink
Different
Node

Un-Auth
Report
Permalink
Same Node

Auth
Report
Permalink
Different
Cluster

Auth
Report
Permalink
Different
Node

Auth Report
Permalink
Same Node

SupportedSupportedSupportedNot
Supported

Not
Supported

Not
Supported

Un-Auth Dashboard

SupportedSupportedSupportedNot
Supported

Not
Supported

SupportedAuth Dashboard

SupportedSupportedSupportedNot
Supported

Not
Supported

SupportedDashboard Viewer
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C H A P T E R 6
Schedule Report

• Overview, on page 49
• Schedules Actions, on page 50
• Create a Schedule for a Report, on page 50
• Daylight Saving Time and Scheduled Reports, on page 54

Overview
You can automate the generation of reports on a regular and recurring basis by setting up a schedule. The
Schedules entity lets you run large dataset reports once to be sent to, and viewed by, many users.

Only users with Report Designer and System Configuration Administrator roles can access the Schedules
entity. System Configuration Administrators can perform all schedule related functions on any reports. They
can view, edit, and run any scheduled report and can create a schedule for any report. Report designers can
create a schedule only for those reports that they created or for which they have View permissions.

You cannot schedule Live Data reports.Attention

You can schedule reports to:

• Run at predetermined times

• Automatically email reports

• Save reports to remote location

The schedules run based on the server time zone and hence on the Schedules page, the columnNext Scheduled
Run reflects the server time zone.

Note
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Schedules Actions
DescriptionAction

Toolbar Actions

Searches for a Schedule.Search

Lists all the schedules (Large, Disabled, Email, and SFTP).All

Lists all large schedules.Large Schedules

Lists all disabled schedules.Disabled

Lists all the schedules configured for email distribution.Email

Lists all the schedules configured to be saved in a remote location.SFTP

Refreshes the Schedules page.Refresh

Creates a new schedule. For more information, see Create a Schedule for a
Report.

New

Ellipsis (…) Actions

Edits a schedule.

You can also click on the Schedule Name to edit the schedule details.

In the edit mode, you can click the icon next to the Schedule name to edit the
Schedule properties; Name and Schedule Type.

Edit

Enables or disables a schedule.Enable or Disable

Deletes a schedule.Delete

Related Topics
Create a Schedule for a Report, on page 50

Create a Schedule for a Report

You cannot schedule Live Data reports.Note

Procedure

Step 1 In the left navigation page, click Schedules.
Step 2 Click New.
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Step 3 In the Create New Schedule dialog box, enter a name for the Scheduler, and select the Scheduler Type. The
available Scheduler Types are:

• Large Schedule

• Visible only for System Configuration Administrator.

• Use Large Schedules for large reports with over 8000 rows.

Large Schedules have an upper limit of 25000 rows.Note

• Large Schedules support only the CSV file formats.

• System Config Administrators can create a maximum of six Large Schedules. You can contact your
administrator to increase or decrease the number of Large Schedules.

• You can limit Large Schedules to a frequency of once a day.

When there are multiple Large Schedules, ensure not to schedule them simultaneously.Important

• Regular Schedule

Step 4 Click Next.
Step 5 In the Report Scheduling tab, select the report to be scheduled, set the filter data, and configure the schedule

details.

DescriptionField

Report

Select the report to be scheduled.Report

Select this check box to enable the Filter Criteria button. Click the Filter
Criteria button to set the filter criteria for the report.

For more information on setting filters for a report, see Report Filters.

If unchecked, the default filter is used.Note

Set Filter

Schedule

Click the calendar icon to select the Start Date.

The Start Date uses the user's time zone settings. If no time zone is
set for the user, the reporting server time zone is applied.

Note

Start Date

Select an option for the End Date:

• None—indicates no end date.

• By—click the calendar icon to select the end date.

End Date
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DescriptionField

Specify the recurrence pattern for the scheduled report.

Schedules that reach the end date are purged after a 24-hour
retention period.

Note

• Once—Specify the time of day for the single occurrence.

• Daily—Specify a number for recurrence of days; for example, every four
days.

• Weekly—Specify the number of weeks and the days of the week that you
want the scheduled report to be run.

• Monthly—Select a day of the month and specify the number of months that
you want the scheduled report to run.

Use Last to specify the last day of the month.Note

Recurrence

Specify the number of times the report must run on the scheduled days.

The maximum frequency with which you can schedule a report is
once in every five minutes.

The maximum frequency with which you can run Large Schedule
is once per day.

Note

Frequency

Step 6 Click Next.
Step 7 In theDestination Setting tab, set up a schedule to email the scheduled report and save the report CSV format

in a remote location.

You can configure the email server in the Administration Console. Contact the administrator for assistance
or for more information, see the Administration Console User Guide for Cisco Unified Intelligence Center at
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-intelligence-center/products-maintenance-guides-list.html.

DescriptionField

Email

Enable the switch and enter the recipient email addresses.

Email page validation occurs when the email address is entered in
the Email Distribution field. No validation is performed if there
is no email ID entered in the Email Distribution field.

Note

Email Distribution

Select the view of the report that you want to email.

Only grid views can be scheduled.Note

Email View

Enter text for the subject line.Email Subject
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DescriptionField

Select the type of file.

• INLINE HTML—Sends the report in HTML format.

• The historical report has an upper limit of 8000 rows.

• The real-time report has an upper limit of 3000 rows.

• XLS—Sends the report as a Microsoft Excel file attachment.

The custom formatting of DECIMAL data type is not applied
for reports exported in excel.

Note

• The historical report has an upper limit of 8000 rows.

• The real-time report has an upper limit of 3000 rows.

• PDF—Sends the report as a PDF file attachment in either landscape or
portrait orientation.

The maximum number of PDF reports that you can schedule
to be sent by email at a given time is 10.

Note

The generated PDF attachments have the following limitations:

• Uses standard font sizes. 10 pixels for the landscape orientation and 8
pixels for the portrait orientation. The PDF bypasses the font size that
is set in the grid view editor to keep the font output printer-friendly.

PDF supports images only in the HTTP format.Note

• Retains rows that fit on the page for the selected orientation. Columns
that do not fit on the page are truncated.

• Only 1000 rows are supported for a PDF file attachment. An email
message is sent if the scheduled report exceeds 1000 rows.

• Does not support word-wrap for columns. In case of larger text, you
can customize the column width in the grid editor to avoid overlaps.
As a result, the customization may reduce the number of columns that
are shown in the PDF.

Email File Type

Remote Location

Enable the switch and select SFTP to establish secure connection to the remote
location.

Protocol

Select the view of the report to be posted.Report View

Enter the IP address of the remote location.Host

Enter a Port number for the SFTP. The default port number is 22.Port
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DescriptionField

Enter the location on the host to save your .csv file. Directory Path must be an
absolute path.

Directory Path

Enter a username and the corresponding password for the host. Maximum
Password Length: 50 characters.

User Name, Password

Click to test the connection.Test Connection

• Date Time format in a scheduled report of type CSV is: Day_of_weekMonth Date_of_Month
HH:MM:SS SERVER_TIMEZONE YYYY. For Example, Fri Oct 24 01:00:00 EDT 2014.

• The time field in a scheduled report of type CSV is displayed in seconds only.

Note

Scheduled Reports generated usingRemote Location option does not support formatted reports.
To get formatted reports, use Email as the Destination Setting.

Note

When you edit a scheduled report and click Save, the scheduler runs and emails the scheduled
report to all the recipients that are configured in the Email Distribution field.

Note

Step 8 Click Save.

Scheduler relies on the Refresh Rate parameter in the Report Definition. You can configure the Refresh Rate
parameter lower than the Scheduler Frequency.

Note

Related Topics
Types of Filters
Report Filters, on page 20

Daylight Saving Time and Scheduled Reports
Daylight saving time affects the scheduled reports in the following ways:

1. Reports that are scheduled to run daily during a particular time of the day are skipped for the day when
the clock advances (for example, due to daylight saving). For example, for a report that is scheduled to
run at 10:30 p.m. daily, if the clock advances by 1 hour then the report that is scheduled to run at 10:30
p.m. will be skipped for that day.

2. Reports that are scheduled to run only once, are updated with a new schedule time with some offset if it
falls in the period that advances. For example, if the clock advances by one hour for a report scheduled
to run once at 10:30 p.m., then the schedule report run time updates to 11:30 p.m.
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C H A P T E R 7
View Help

• View Cisco Unified Intelligence Center Help, on page 55
• Get Help on Cisco Unified Intelligence Center, on page 55
• Get Help on a Report, on page 55

View Cisco Unified Intelligence Center Help
In Cisco Unified Intelligence Center, two types of help are available:

• Application-specific help: This help content explains how to use Unified Intelligence Center in general.

• Report-specific help/Template help: This help content explains how to use the report. The help can
describe the fields or provide details of the relationship between the fields, or it can explain how to
interpret the data in the report. This help is available only if it has been created for the report.

For more information on how to add the template help to report, see Add Template Help section.

Related Topics
Add Template Help, on page 19

Get Help on Cisco Unified Intelligence Center
• Click theHelp icon on the top right corner of each of the entity listing page to view help contents specific
to that entity.

• Click theOnline Help button on the home page to access the help window for Cisco Unified Intelligence
Center.

Ensure to accept the certificate to view the help content.Note

Get Help on a Report
To get help on a report, perform the following steps
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Procedure

Step 1 From the Reports page, click the required report to open the report in the run mode.
Step 2 Click the Template Help icon in the report toolbar.

The report template help appears in a new browser window.

You can configure template help for the report from the Reports page > Add Help. For more information,
see Add Template Help section.

Related Topics
Add Template Help, on page 19
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C H A P T E R 8
Unified Intelligence Center Gadgets in Cisco
Finesse

• Configure Live Data Gadgets in Cisco Finesse with compositeFilterId, on page 57
• Configure Historical Report Gadgets in Cisco Finesse, on page 58
• Live Data Failover, on page 60
• Gadget Toolbar Improvements, on page 60

Configure Live Data Gadgets in Cisco Finesse with
compositeFilterId

The compositeFilterId filter is used in gadget filter criteria to achieve the advanced filter criteria. The following
example illustrates the compositeFilterId filter usage for advanced filtering in Cisco Finesse desktop.

To add mrDomainID to the existing "Agent Skill Group" live data gadget filter criteria, perform the following
steps:

Procedure

Step 1 Retrieve the existing gadget configuration for "Agent Skill Group" report from the desktop layout:

<gadget>https://my-cuic-server:8444/cuic/gadget/LiveData/LiveDataGadget.jsp

?gadgetHeight=310&viewId=9AB7848B10000141000001C50A0006C4&filterId=agent.id=CL</gadget>

Step 2 Run the "Agent Skill Group" live data report in Unified Intelligence Center and click the Field Filters tab.
Step 3 Copy the Field Filter name to add to the existing filter criteria and assign the filter value as illustrated in the

following syntax:

<gadget>https://my-cuic-server:8444/cuic/gadget/LiveData/LiveDataGadget.

jsp?gadgetHeight=310&viewId=9AB7848B10000141000001C50A0006C4&filterId=agent.id=CL

&compositeFilterId=agent.agentMRDs.mrDomainID=<mrdomainId></gadget>

Where,

• filterId is for basic filter criteria.
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'loginId' and 'teamName' work as place-holders in the filterId parameter:

• 'loginId' is replaced with the logged in user Id.

• 'teamName' is replaced with the team that the logged in user belongs to.

Note

• compositeFilterId is for Advanced filtering.

• agent.id and agent.agentMRDs.mrDomainID are the keys to identify the filter field names.

• CL is the value for agent.id to identify all the collections on which agent.id has permissions.

• mrdomainId is the value for the key agent.agentMRDs.mrDomainID to filter on the given mrdomainId
by replacing the tag <mrdomainId> in the above URL.

Ensure to:

• Replace <my-cuic-server> with the FQDN of the Cisco Unified Intelligence Center server.

• Use HTTPS based on how the Cisco Finesse desktop is being accessed.

• Replace <mrdomainId> with the appropriate mrdid.

• If the filter is associated with a value list (example in the above URL), <mrdomainId> can
be replaced with CL to consider all the collections of the value list in the following syntax:

compositeFilterId=agent.agentMRDs.mrDomainID=CL

This example is for illustration purpose only. (As mrdomainId cannot be associated with a
value list based on existing 'Agent Skill Group' stock report.)

• For configuring multiple views in the gadget, use viewId, filterId and compositeFilterId
parameters with numbering in the gadget URL like: viewId_{1...5}, filterId_{1...5},
compositeFilterId_{1...5}

<gadget>https://my-cuic-server:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?

gadgetHeight=310&viewId_1=9AB7848B10000141000001C50A0006C4&

filterId_1=agent.id=CL&compositeFilterId_1=agent.agentMRDs.mrDomainID=1&

viewId_2=99E6C8E210000141000000D80A0006C4&filterId_2=agent.id=CL%20teamName&

compositeFilterId_1=agent.agentMRDs.mrDomainID=1<mrdomainId></gadget>

Note

Configure Historical Report Gadgets in Cisco Finesse
Use the following code snippet to configure the Cisco Unified Intelligence Center Historical reports in Cisco
Finesse Desktop.
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In Enterprise deployment (Unified CCE and Packaged CCE), Cisco Unified Intelligence Center Historical
reporting gadget is available out of the box on Cisco Finesse Supervisor desktop only and is not supported
on Agent desktop.

For Historical Gadgets, only one view is supported.

Note

Cisco Unified Intelligence Center Historical Report does not support Grouping and Drill-downs in Cisco
Finesse Desktop.

Note

Code Snippet

<gadget>https://<my-cuic-server>:8444/cuic/gadget/Historical/HistoricalGadget.jsp?gadgetHeight=310
&viewId=F2D86F191000015B000000640A4E5A54&linkType=htmlType&viewType=Grid
&EventTime=RELDATE%20LASTWEEK&User=VL%20CUIC%5Cadministrator</gadget>

'~loginId~' and '~teams~' work as place-holders in the filter criteria:

• '~loginId~' is replaced with the logged in user Id.

• '~teams~' is replaced with the teams that the logged in user supervises.

Examples:

https://my-cuic-server:8444/cuic/gadget/Historical/HistoricalGadget.jsp?viewId=
BD9A8B7DBE714E7EB758A9D472F0E7DC&linkType=htmlType&viewType=Grid&refreshRate=900&@start_date=
RELDATE%20THISWEEK&@end_date=RELDATE%20THISWEEK&@agent_list=CL%20~teams~&gadgetHeight=360

https://my-cuic-server:8444/cuic/gadget/Historical/HistoricalGadget.jsp?viewId=
BD9A8B7DBE714E7EB758A9D472F0E7DC&linkType=htmlType&viewType=Grid&refreshRate=900&@start_date=
RELDATE%20THISWEEK&@end_date=RELDATE%20THISWEEK&@agent.id=~loginId~

Note

• https://<my-cuic-server>:8444/cuic/gadget/Historical/HistoricalGadget.jsp?gadgetHeight=310

—Indicates the Historical Gadget URL.

• &viewId=F2D86F191000015B000000640A4E5A54&linkType=htmlType&viewType=Grid

—Indicates the default report permalink filters.

You can retrieve this information from any report permalink.Note

• &EventTime=RELDATE%20LASTWEEK&User=VL%20CUIC%5Cadministrator</gadget>

—Indicates the variable parameters that you can customize in addition to the default report permalink.

For more information on applying the variable parameters, see Variable Parameters in a Permalink
section in the Cisco Unified Intelligence Center Report Customization Guide at
https://www.cisco.com/c/en/us/support/customer-collaboration/unified-intelligence-center/products-user-guide-list.html.
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Live Data Failover
Live Data reports can be viewed as gadgets in the Cisco Finesse desktop and on the report viewer in Unified
Intelligence Center. Live Data failover occurs when any of the following fails:

• Live Data Socket.IO Service

• Network Connectivity

• Live Data Web Service

• Unified CCE Live Data NGINX Service

“Live Data is not available after repeated attempts. Retrying” message is
displayed during failover when the gadget and the report viewer aren’t able to connect to the primary and
secondary Live Data server. The gadget and Unified Intelligence Center continue to retry until it connects to
one of the servers and regain updates to the reports.

The Live Data gadget fails to load if the Intelligence Center Reporting Service is unavailable when the Live
Data gadget is being rendered. If the service is unavailable after the gadget is rendered, it has no effect. By
configuring the alternateHosts attribute to have a fallback Cisco Unified Intelligence Center VM host name,
you can achieve failover for the Intelligence Center Reporting Service. For more information, see the
alternateHosts Configuration section in the Cisco Finesse Administration Guide at https://www.cisco.com/
c/en/us/support/customer-collaboration/finesse/products-maintenance-guides-list.html.

Gadget Toolbar Improvements
Cisco Unified Intelligence Center provides you with a toolbar on Live Data reporting gadget on the Cisco
Finesse Desktop.

You can remove this toolbar by configuring the parameter hideGadgetToolbar to true in the gadget URL.

For example: <gadget>https://my-cuic-server:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=
150&hideGadgetToolbar=true&viewId=EF94123F10000164000000FD0A6B2D41&filterId=
AgentCallLogDetailStats.agentID=loginId</gadget>

If the parameter hideGadgetToolbar is unavailable in the gadget URL or if it is set to false, then the toolbar
is displayed by default.

Note

Reports View Selector

As a reporting gadget user, you can select and view multiple reports from the Reports View Selector on the
toolbar.

The Reports View Selector is a drop-down list that displays the list of reports in the Report name - View
name format. The Report View Selector list allows you to view the five report views.
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• For Historical Gadgets, only one view is supported.

• To add a new report to the Reports View Selector, contact the Cisco Finesse Administrator.

Note

Toolbar Hide or Unhide

The gadget toolbar displays an arrow tab in the center to hide and unhide the toolbar.

Click the arrow tab to hide the toolbar on the reporting gadget to get a clear view of the report.

When you click the arrow tab again, the toolbar becomes visible on the gadget. When you hover over the
arrow tab, the hide and unhide message is displayed.

Pause and Play

You can pause and resume event updates in Live Data gadgets using the pause or play icons respectively. As
a reporting user, the pause or play button works as follows:

• Pause - The updates are stopped.

• Play - The updates resume and are displayed on the gadget.

When the button is paused and updates are available on the gadget, a notification appears over the pause or
play button.

Note

Show Threshold Only

When you check the Show Thresholds Only box, only rows with matching threshold values are displayed
in the report. By default, this check box is unchecked for every report.

Gadget Help

The gadget toolbar displays a Help icon. When you click the help icon, a window appears, displaying the
report template help for the relevant reporting gadgets.
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